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100 Introducing Inspiration 
Items shown as this mean you do this part
Ordinary text is information 

and text like this is help notes and tips
Inspiration has two main views or environments: 

Diagram View 

As you work, both keep track of your ideas. Sometimes you will work exclusively in Diagram View to create a graphical organizer or a map showing how ideas or concepts interconnect.
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Here’s what Diagram View looks like. 

Symbol Diagram Starting point, main palette toolbar idea or central theme Note 

Formatting toolbar Subtopic or subpoint 
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In Inspiration, you think and learn visually. Inspiration allows you to create a picture of your ideas or concepts in the form of a diagram. It also provides an integrated outlining environment to develop your ideas into organized written documents. Inspiration’s combination of visual and linear thinking helps deepen understanding of concepts, increase memory retention, develop organizational skills, and tap creativity. 

1. Open Inspiration in your main idea balloon double click inside the balloon box and type my big idea
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2. Drag an oval symbol from the toolbar onto the diagram view
3. Arrange the balloon where you want then type idea 1
4. [image: image70.png]
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Using the diamond link drag a link from My Big Idea to Idea 1 – when you see position handlebars 

5. [image: image72.png]


Click to link the two balloons

You can double click on the link to remove it.
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Click here to move to more symbols

6. You can re-size the balloon with the size handles 


                                                                  Link points

                                                                 Re-size handles
Insert three more toolbar balloons using symbols or different objects 

7. Add a text box and change the background colour

8. Next make a chart of the Technology Process
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Now try a short tutorial

Entering the main idea or topic 

When you open Inspiration, a symbol appears in the centre of the screen, with the placeholder text, Main Idea, selected. It’s easy to get started—just enter a topic. 

• 
Type the diagram topic, Career Thoughts, into the Main Idea symbol. 

Using the Create tool to add a new linked symbol 


There are many different ways to create new symbols in Diagram View. An easy way to add a linked symbol is to use the Create tool. 

The Create tool adds a new linked symbol in the direction you choose. 

1. 
Select the Career Thoughts symbol. On the Diagram toolbar, position the cursor over the upper right point on the Create button. 

Click the upper right point to create a new, linked symbol in that direction. 

When you roll over a point on the Create button, it highlights to show the direction in which the new symbol will be created. 

2. 
Click the upper right point. A new symbol appears connected to and diagonally above the Career Thoughts symbol. This symbol is selected and ready for you to enter an idea. 

3. Type Enjoy my job into the new symbol. 

Trying it again 

Now use the Create tool again to add a second linked symbol. 

1. Select the Career Thoughts symbol. 

This time, you’ll notice there’s a Subtopic Quick Control near the upper right corner of the symbol. The Subtopic Quick Control appears next to a symbol to show that it has a sub​topic. 

2. On the Diagram toolbar, position the cursor over the lower left point on the Create button. 
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Click the lower left point to create a new, linked symbol in that direction. 

3. 
Click the lower left point. 

The new symbol appears connected to and diagonally below the Career Thoughts symbol. 

4. 
Type Things I like to do into the new symbol. 

5. 
Press Shift+Return (Shift+Enter) to end text entry and select the symbol. 

Here’s what the diagram looks like now. 
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Using the RapidFire tool to quickly capture ideas 

You’re going to use the RapidFire tool to brainstorm things you like to do. The RapidFire tool adds a series of linked ideas to a symbol. This allows you to concentrate on entering information, rather than creating symbols one at a time.

RapidFire places ideas in a freeform structure. There’s no need to think about organizing yet; you’re still getting ideas down to “see” what you think. You’ll learn more about organizing the information later in this tutorial. 

1. 
Select the Things I like to do symbol, if it’s not already selected. On the Diagram toolbar, click the RapidFire button. 
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The RapidFire icon appears in the symbol to show the tool is turned on. 
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RapidFire icon 

1. Type Fix things and press Return (Enter). 

2. Type Tinker with cars and press Return (Enter). 

3. Type Work in the garden. 

4. Click the RapidFire button again to turn the RapidFire tool off. 

Here’s what the diagram looks like now. 
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Tip: If you made a mistake while entering text into a symbol, don’t worry. It’s easy to ﬁx. Simply double-click the text in the symbol. Then select the words to change and type over them. You can also insert text by clicking where you want to make a correction and entering the new text. 

Adding an unconnected symbol using point and type 

Sometimes you want to add an idea, but you’re not exactly sure where it ﬁts. You can easily add an unconnected idea to a diagram using point and type. Inspiration automatically creates a symbol to hold the text. 

Click in the open area in the diagram directly to the right of the Career Thoughts symbol. 

5. Type Not in an ofﬁce. 

Inspiration automatically creates a symbol to hold the text. This symbol is not linked to any other symbol. 

Click away from the Not in an ofﬁce symbol to deselect it. 

Replacing a symbol with one from the Symbol palette 

Once you get some ideas down, it’s easy to replace a symbol already in the diagram with one from the Symbol palette. Inspiration offers over 1,300 colorful, high-resolution symbols, including several hundred photographic-quality images and animated symbols. The symbols are organized into categories and libraries. 

1. Select the Tinker with cars symbol. 

2. On the Symbol palette, click the Select Library button 
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to navigate to the Everyday category. Choose the Transport 1 library. 

3. Click the gray car. 

The Tinker with cars symbol automatically changes to the shape of this car. 

Here’s what the diagram looks like now. 
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Using drag and drop to add a speciﬁc symbol 

You can also use drag and drop to add a symbol from the Symbol palette to represent a new idea. When you add a symbol using drag and drop, the symbol is not connected to any other symbols. 

1. On the Symbol palette, click the Select Library button 
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to navigate to the Geography category. Select the Landforms library. 

2. 
Drag the Mountains symbol until it’s positioned above the Work in the garden symbol and release the mouse button. 
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Linking symbols 

Now it’s time to add links. Links show the connections and relationships between ideas. 

Select the Career Thoughts symbol. This is the symbol where the link will start. 

On the Diagram toolbar, click the Link button to turn on the Link tool. 
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The cursor now looks like this 
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3. 
Click the Not in an ofﬁce symbol. This is the symbol where the link will end. A link with the arrowhead pointing to the Not in the ofﬁce symbol appears. 

4. 
Click the Career Thoughts symbol again. 

5. 
Now click the Mountains symbol. 

A second link appears and the arrowhead points to the Moun​tains symbol. 

6. 
Click the Link button again to turn off the Link tool. 

Here’s what the diagram looks like now. 
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Adding text on the link 

Each link has a text box that appears when the link is selected. Adding text to this box deﬁnes the relationship between the symbols. 

1. Select the link between the Career Thoughts symbol and the 

Mountains symbol, if it’s not already selected. When a link is selected, you see the outline of the text box associated with that link. It’s ready for you to begin typing. 

2. Type out of the city. Click off the link to deselect it. 

Here’s what this section of the diagram looks like now. 
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Adding a note to a symbol 

For each symbol in a diagram, a note is available. Notes allow you to expand ideas and actually begin the writing process, while continuing to work in the visual format. 

1. 
Select the Mountains symbol. On the Diagram toolbar, click the Note button. 
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A note opens below the symbol. 

2. Type I’d like to live here. into the note. 
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Moving a note 

Because people work in different ways, notes are ﬂexible. After you add a note to a symbol, it’s easy to move the note to another location on the symbol, or to any open place in the diagram. 

3. Select the open note. 

Click the note title bar and drag the note so that it touches the right side of the Mountains symbol. 

Here’s what the diagram looks like now. 
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Moving symbols 

You can also move a symbol to another location in the diagram. 

Select the Work in the garden symbol. 

Drag the symbol so it is directly below Things I like to do, and between the Tinker with cars and Fix things symbols. Release the mouse button. 

Inspiration keeps the link attached so you never lose the con​nection between ideas when you rearrange the diagram. 

Here’s what the diagram looks like now. 
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Changing the color of symbols 

Color is great for customizing the look of symbols. It helps distinguish items in a diagram and is often used to identify a group of related ideas. 

1. 
With the Work in the garden symbol still selected, also select the Things I like to do and Fix things symbols. To select more than one item, press the Shift key and click each item, or click and hold down the mouse to drag a selec​tion box around the symbols. 

2. 
On the Formatting toolbar, click the Fill Color button and choose a color from the palette. 
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When you change the ﬁll color of a symbol, the color inside  the symbol changes. 

Select a light color, such as light purple. This lets the text con​tinue to show up nicely against the symbol’s ﬁll color.

3. 
Click off the symbols to deselect them. 

Changing the colors in a multicolor symbol 

Changing the colors in a multicolor symbol allows you to further customize your work. You can change the colors in any multicolor symbol in the symbol libraries. 

4. Select the Tinker with cars symbol. On the Formatting toolbar, the existing colors in the symbol appear in order of most frequently occurring to least frequently occurring. 

5. Click the ﬁrst color, light gray, and select a new color from the palette that matches the look of the other Things I like to do subtopics. This color will replace the light gray color that appears in the Tinker with cars symbol. 

Saving your work 

Whenever you’re working on a document, it’s a good idea to save it on a regular basis. To save a document for the ﬁrst time, or to save a document you’ve already saved before under the current name, use the Save command. 

On the File menu, choose Save. The dialog box appears with the main idea as the name of the ﬁle. 

If necessary, navigate to the folder in which you want to save the diagram. 

Click Save. In Windows, the ﬁle is saved with an .isf extension. 

Quitting Inspiration 

If you’re ready to take a break from the tutorial, you can quit Inspiration after saving your changes. If you want to continue, just skip this procedure and turn to the next mini-lesson. 

To close your ﬁle and quit Inspiration, on the File menu, choose Quit (Exit). If you’ve made changes to the document, Inspiration asks if want to save those changes. 

Click Yes to save your changes and quit Inspiration. 

Outline View. 

Other times you will work in Outline View where you might organize and write a report. 

And here is what Outline View looks like. 

Uses of diagrams 

In Inspiration, you can create many types of visual diagrams. It doesn’t matter if you’re planning a project, looking at cause and effect, or developing your understanding of a complex concept. The kind of diagram you create in Inspiration depends on the idea you want to develop. Here are some of the different types of diagrams you can easily build using Inspiration: 

Concept map 

A concept map is a hierarchical diagram used to represent a set of concepts, beginning with the most general or most important, and then working down to more speciﬁc detail. Key concepts are connected by links that have descriptive words on them explaining the relationship between the concepts. 

Concept maps are often used to illustrate scientiﬁc or historical concepts or for other types of knowledge mapping. 
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The Skin diagram is an example of a concept map. 

Idea map 

An idea map is used to brainstorm ideas and develop thoughts. Idea maps start with the main idea or problem in the middle of the screen. You record ideas associated with this topic in symbols that radiate from it. The symbols connect to the main idea with links. Subtopics or speciﬁc details are then added to those ideas. You let the ideas ﬂow and then step back and look at main themes, patterns, or possible solutions. 

Idea maps can be used for individual or group brainstorming, planning, problem solving, and report writing. 
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The Blue diagram is an example of an idea map. 

Web 

A web is a visual map that shows how different bits of information relate to each other. A web has a main idea or core concept at the centre, with different categories of information connected to it. Ideas, facts, and information are connected to the categories to support them. 

Webbing is particularly useful when you’re analysing a story, or brainstorming ideas for a plan or written report. 
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The Hatchet diagram is an example of a web. 

Storyboard 

A storyboard is a visual way to organize projects such as multimedia presentations or the design of a web page. A storyboard helps you plan what you’re going to say and show, and ﬁgure out which ideas belong at the beginning, middle, and end. In a storyboard, each symbol can represent a different slide, screen, or page. 
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The Science Fair Web Site Plan diagram is an example of a storyboard. 

Uses of outlines 

When you make an outline, you create a hierarchical structure for your ideas. An outline helps organize written documents, speeches, or plans by providing a framework for ideas, and by letting you order the ﬂow of information. 

You will ﬁnd outlining particularly useful for planning and for structuring information when writing. While the structure of an outline is simple, outlines can help you organize very complex material. 
Inspiration opens in Diagram View where you process, organize, and prioritise information visually. Key functions are right at your ﬁngertips with the Diagram toolbar along the top, the Formatting toolbar at the bottom, and the Symbol palette on the left. 
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Mini-lesson Two: Outline View 

Inspiration’s diagramming and outlining environments are fully integrated. While you’ve been creating a visual map of your ideas in Diagram View, Inspiration has also been working behind the scenes, building an outline of your work. 

In this second mini-lesson, you open the diagram created in the previous lesson and work with it in Outline View. You will learn the following: 

How to switch to Outline View 

How to add a topic 

How to add a subtopic 

How to move a topic by dragging 

How to change the level of a topic 

How to hide and show subtopics and notes 

How to add notes text 

How to change topic defaults 

How to change topic preﬁxes 

How to print an outline 

Tip: If you quit Inspiration, you need to start the program and open the Career Thoughts document. 

Switching from Diagram View to Outline View 

When you switch to Outline View, your information is structured in a conventional hierarchy. 

Select the Career Thoughts symbol. 

To view a diagram in Outline View, click the Outline button on the Diagram toolbar. 
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Subtopic Quick Control 

Note Quick Control 

The diagram is transformed into an outline. The symbols now appear as topics and subtopics and the notes text is visible. Even though you did not name the Mountains symbol in Diagram View, the Picture-to-Topic option automatically provided a label for the topic, to ensure you did not lose the relationships between ideas when you switched views. 

Here’s what your outline looks like now. 

Selection control column Outline toolbar 

Formatting toolbar 
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Adding a topic 

You can add a new topic in Outline View as easily as you added a new symbol in Diagram View. 

If it’s not already selected, select the Career Thoughts topic by clicking in the Selection control column. A selection box appears around the topic to show it’s selected. 

On the Outline toolbar, click the Topic button. 
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Inspiration inserts a new topic and automatically assigns it a preﬁx. The cursor moves to the new line so you’re ready to enter text for your new idea. 

3. 
Type Work outside. 

Adding a subtopic 

It’s also easy to add new subtopics. These ideas provide information subordinate to or supplemental to a topic. 

1. 
With Work outside selected, click the Subtopic button on the Outline toolbar. 
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When you add a subtopic to a topic, Inspiration automatically indents it one level below the selected topic and assigns it a preﬁx. The cursor also moves to the new line so you can enter text for the new idea. 

2. 
Type Maybe in a national forest. 

Here’s what this section of the outline looks like now. 
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Moving a topic by dragging 

There are many ways to organize your outline. One of the easiest is simply dragging a topic (and its subtopics) up or down in the outline. 

Select the Not in an office topic. 

 Drag the topic so it is positioned directly below the Maybe in a national forest subtopic. Release the mouse button. 

While you drag, the topic remains in its original position until you release the mouse button. You can tell where the topic’s new location will be by watching the black line as you drag. The small arrow on the line indicates the level of the topic’s new location. 

The Not in an office topic now appears as a subtopic of Work outside, at the same level as the Maybe in a national forest subtopic. 

Here’s what the outline looks like now. 
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Changing the level of a topic 

If you decide a topic belongs at a lower level in the outline, it’s easy to move it down in the hierarchy. 

1. Select the Tinker with cars topic. 

2. On the Outline toolbar, click the Right button. 
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The Tinker with cars topic moves to the right and is now a sub​topic of Fix things. 

Here’s what this section of the outline looks like now. 
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Hiding subtopics 

To make it easier to organize an outline, it’s often useful to hide subtopics so you can concentrate on the main topics. 

1. Click the Subtopic Quick Control 
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to the left of the Things I like to do topic. The subtopics for this topic are now hidden. 

2. Click the Subtopic Quick Control again to show the subtopics. 

Adding notes text to a topic 

Notes text is a good way to further develop ideas in Outline View. You can add anything from one sentence to several pages of text. 

1. Select the Work in the garden topic. 

2. On the Outline toolbar, click the Note button. 
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The cursor moves to a new line so you can enter the notes text. 

3. Type I’ve done some great plant experiments. 

When you add a note, a Note Quick Control 
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appears in the Note control column to the left of the topic. 

Hiding and showing notes text 

Just as you can hide and show subtopics, you can hide and show notes text. 

1. With the Work in the garden topic selected, click the Note 

Quick Control 
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 to hide the notes text. The status of the Note Quick Control changes to show that the 

note is now hidden 
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. 

2. Click the Note Quick Control again to show the note. 

Setting topic defaults 

You can set the defaults for any or all topic levels and notes. The default options include font, text size, text color, and other style choices. 

1. Select the Career Thoughts topic. On the Formatting toolbar, 

click the Topic Defaults button 

The Topic Defaults dialog box appears. 
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2. 
Select Level 1 and change the color to bright blue. Click Preview. 

3. Change the font to Helvetica. Click OK. Here’s what the outline looks like now. 
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Changing topic preﬁxes 

You can also change outline preﬁxes. There are a variety of preﬁx styles available. 

1. On the Formatting toolbar, click the Preﬁx button 
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. 

Select a new preﬁx style. 

All of the preﬁxes in the outline are changed to reﬂect your selection. 

Printing the outline 

Before you print the outline, you can determine layout, margins, headers and footers, etc. by selecting Page Setup on the File menu. Page Setup also allows you to preview the outline before printing and, once you’re ready, to print the outline. 

On the File menu, choose Page Setup. 

Make your selections and choose Print Preview to preview your work. 

Click Print to print your outline. 

Taking a break 

If you’re ready to take a break from the tutorial, save your changes and quit Inspiration. If you want to continue, just skip this procedure and turn to the next mini-lesson. 

Mini-lesson Three: Returning to Diagram View 

Since the Inspiration views are fully integrated, when you return to Diagram View, you’ll ﬁnd the diagram has changed to reﬂect the work done in Outline View. 

In this ﬁnal mini-lesson, you return to Diagram View and complete the Career Thoughts diagram as you learn each of these procedures: 

How to switch to Diagram View 

How to automatically arrange a diagram 

How to change the view scale 

How to position a diagram in the window 

How to change symbol defaults 

How to change the colors of a note 

How to add a hyperlink 

How to record a sound 

How to print a diagram 

How to export a diagram 

Tip: If you quit Inspiration, you need to start the program and open your Career Thoughts document. 

Switching from Outline View to Diagram View 

1. Select the Career Thoughts topic, if it’s not already selected. 

2. On the Outline toolbar, click the Diagram button. 
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The outline is transformed into a diagram. 

Here’s what the diagram looks like now, including the work done in Outline View. 

[image: image47.jpg]ouror e ey




Arranging the diagram 

The Arrange tool arranges a diagram into various formats. 

1. On the Diagram toolbar, click the Arrange button. 

The Arrange dialog box appears. 

2. In the Links list, choose Standard. 

3. In the Diagram Type list, choose Top Down Tree. 

4. Click OK. The diagram automatically rearranges in the new format. Here’s what it looks like now. 
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Changing the view scale 

Magnifying and reducing the view allows you to work with speciﬁc parts of your diagram or outline, or to see the entire screen at one time. To see more of a diagram or outline in the window, you zoom out. To make symbols or topics look bigger, you zoom in. You can also zoom in or out to a speciﬁc percentage. 

1. On the Scroll bar, click the Zoom In button 

[image: image50.jpg]


one time. This makes the diagram appear larger on the screen. 

2. If you’d like the diagram to appear smaller on the screen, click 

the Zoom Out button 
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Positioning the diagram in the window 

To work with a speciﬁc section of your diagram, you can also move the diagram around within the window. 

1. On the Formatting toolbar, click the Position button 
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. 

Click and drag the diagram in the direction you want. 

You can click and drag as many times as you need until the diagram is where you want it in the window. 

Click the Position button again to turn the Position tool off. 

Changing symbol defaults 

Changing the defaults for symbols allows you to easily create multiple symbols with the same characteristics. 

1. Select the Work outside symbol. 

2. 
On the Formatting toolbar, click the Fill Color button. Select a light blue color from the palette. 

The color inside the symbol changes to reﬂect your selection. 

3. With the Work outside symbol still selected, click the Line Color button. Select a dark red color from the palette. 
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Click the Line Color button to choose a color. 

The color of the line around the symbol changes to dark red. 

4. On the Formatting toolbar, click the Defaults button 
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. Choose Set Default. 

5. Now select the Not in an ofﬁce and Maybe in a national forest 

symbols. To select more than one item, press the Shift key and click each item, or click and hold down the mouse to drag a selec​tion box around the symbols. 

6. Click the Defaults button 
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, and then choose Apply 

Default. These symbols now exhibit the same formatting as the Work outside symbol. 

Changing the color of a note 

Note colors are also changeable, so you can customize them to match the symbols. 

1. Select the Work in the garden symbol. Click the Note Quick 

Control 
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The note opens. 

2. 
On the Formatting toolbar, click the Fill Color button and choose a light purple color from the palette. This will change the color inside the note. 

3. 
Then click the Line Color button and select a slightly darker purple color from the palette to change the color of the line around the note. Now the note matches this group of symbols. 
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Click the Line Color button to choose a color. 

Adding a hyperlink 

You can further enhance a project by integrating resources from the Internet. You can also hyperlink to a document created with Inspiration or another application. 

1. 
Select the words “national forest” in the Maybe in a national forest symbol. 

2. 
On the Diagram toolbar, click the Hyperlink button. 

The Hyperlink dialog box appears. 

3. 
Select Web Page. The selected text appears in the Hyperlink Text box. 

4. 
In the Link To box, type http://www.fs.fed.us/. Click OK. 

This creates a hyperlink to the USDA Forest Service web page. 

5. 
Click off the symbol to deselect it. 
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Here’s what the diagram looks like now. 
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Recording a sound 

You can annotate diagrams and outlines with recorded comments. 

To record sounds, Record Sounds must be made available in Application Properties, and your computer must have a microphone. You will ﬁnd Application Properties on the Utility menu. 

1. Select the Enjoy my job symbol. 

2. On the Tools menu, point to Sound, and then click Record. 

3. In the recording control box, click Record to begin recording. 

To begin recording, click the Record button. 

To end recording, click Save. 

4. Say It’s important that I have balance in my life. 

5. When you ﬁnish recording, click Save. 

The Audio Quick Control 
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 is now displayed next to the Enjoy my job symbol. Click the Audio Quick Control to play your recorded sound. 
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Taking a ﬁnal look 

Congratulations! You’ve ﬁnished creating your Career Thoughts project. 

Here’s one more look at how the diagram appears on the screen. 
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Printing the diagram 

When you print from Diagram View, the default is Fit to 1 Page, which automatically sizes the diagram to ﬁt on one page. If desired, this can be adjusted so the diagram prints full size on multiple pages. 

1. 
On the File menu, choose Page Setup. 

Here you set up the diagram layout, determine margins, head​ers and footers, and preview your diagram before printing. 

2. 
Make your selections, and then choose Print Preview to preview your work. 

3. 
Click Print to print your diagram. 

Exporting the diagram 

Once you create a diagram or an outline, you can export it for use in a variety of other programs. For example, you can save a diagram in graphic ﬁle format, which opens in other graphic and word processing documents. 
• 
On the File menu, choose Export and make your selections. You can also save diagrams as HTML ﬁles (also called web pages) that can be viewed using a web browser such as Netscape Navigator or Microsoft Internet Explorer. Options include a single web page or even building an entire web site using the Site Skeleton export. 
To export your diagram as HTML ﬁles, on the File menu, choose Export as HTML and  make your selections. 

Congratulations! You’re now ready to use the power of visual learning to develop all of your great ideas. 
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